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Wonder Woman
1984 Official

Trailer
9 August 22,2020 &
admin 0

AdObe PhOtOShOp CC Keyboa rd Warner Bros. Pictures

released Official Trailer

ShOI’tCUtS for Wonder Woman 1984,
£ March 25,2018 & admin the upcoming sequel

to Wonder Woman. Movie
Adobe Photoshop CC Keyboard Shortcuts will help you to work will be release on October

faster & become more productive while using Adobe Photoshop
cC Share this:
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Tools Tools
SHORTCUTS SHORTCUTS SHORTCUTS
History Brush tool 3D Object Rotate tool
3D Object Roll tool
3D Object Pan tool

Rectangular Marquee tool Art History Brush tool"
Eraser tool

Background Eraser tool

own
9 June 23,2020 @

Magic Eraser tool

‘Gradient tool 3D Camera Rotate tool

Magic Wand tool Paint Bucket tool 3D Camera Roll tool
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Quick Selection tool Dodge tool 3D Camera Pan tool

Grop tool 3D Camera Walk tool

Comments Off

3D Camera Zoom
Hand teol

Rotate View tool

N3 Tz

Golor Sampler tool Horizontal Type tool
Vertical Type tool

Horizontal Type mask tool

Zoom tool
Ruler tool
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S
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Patch tool Rectangle tool
Rounded Rectangle tool

Ellipse tool

Red Eye tool*

www.animationboss.net

Polygon tool
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Line tool

Gustom Shape tool
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Scenes

Stamp tool*
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Popular shortcuts
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Free Transform Control +T Command + ’ VEX

Result Windows macOS

T Metropolis for Award-
Winning SPDRS Spot
Decrease Brush Size [ [ 9 April 22,2020 @

) Comments Off
Increase Brush Size ] ]

Decrease Brush Hardness { { Hobbs & Shaw VFX
Breakdown
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Default
Foreground/Background
colors

Switch
Foreground/Background
colors

New layer via copy

New layer via cut

Add to a selection

Delete brush or swatch

Toggle auto-select with move
tool

Cancel any modal dialog
window (including the Start
Workspace)

Select the first edit field of the
tool bar

Navigate between fields

Navigate between fields in
opposite direction

Change Cancel to Reset

Control +

Shift +
Control +

Any selection
tool + Shift-
drag

Alt-click
brush or
swatch

Control-click

Escape

Enter

Tab

Tab + Shift

Alt

Use function keys

Note:

Command +

Shift +
Command +

Any selection
tool + Shift-
drag

Option-click
brush or
swatch

Command-
click

Escape

Return

Tab

Tab + Shift

Option
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volume, etc. For more information on the behaviour of function keys

on your Mac, refer to these Apple documentations: Good
Omen
m macOS Sierra: Use keyboard function keys s VFX
m Change the behavior of function keys on your Mac Breakd
own
9 July 24,2019 ¢ Comments
Result Windows macOS Off
Start Help F1 Help key
“Bruise
Undo/Redo F1 d”
Cut F2 F2
Animated Short Film
Copy F3 F3 £9 July 24,2019 ¢ Comments
Off
Paste F4 F4
Show/Hide Brush panel F5 F5 - Upco
ming
Show/Hide Color panel F6 F6 Marvel
o & Movies
Show/Hide Layers panel F7 F7 & TV
Series
Show/Hide Info panel F8 F8 £ July 21,2019 @ 0
Show/Hide Actions panel F9 Option + F9
Annab
Revert F12 F12 elle
Comes
Fill Shift+ F5  Shift+F5 Home
VEX
Feather Selection Shift + F6 Shift + F6 Breakdown
9 July 18,2019 ¢ Comments
Inverse Selection Shift + F7 Shift + F7 Off
Catch-
Select tools
breakd
own
Holding down a key temporarily activates a tool. Letting go of the key . B uly
10,2019
returns to the previous tool. ®
Note:In rows with multiple tools, repeatedly press the same shortcut Spider-Man: Far From

to toggle through the group. Home VFX Breakdown


https://support.apple.com/kb/PH25425?locale=en_US&viewlocale=en_US
https://support.apple.com/en-in/HT204436
http://www.animationboss.net/good-omens-vfx/
http://www.animationboss.net/bruised-short-animation/
http://www.animationboss.net/upcoming-marvel-movies/
http://www.animationboss.net/annabelle-comes-home-vfx/
http://www.animationboss.net/catch-22-vfx/
http://www.animationboss.net/houdini-customer-reel-2019/
http://www.animationboss.net/good-omens-vfx/
http://www.animationboss.net/good-omens-vfx/
http://www.animationboss.net/bruised-short-animation/
http://www.animationboss.net/bruised-short-animation/
http://www.animationboss.net/upcoming-marvel-movies/
http://www.animationboss.net/upcoming-marvel-movies/
http://www.animationboss.net/upcoming-marvel-movies/#respond
http://www.animationboss.net/annabelle-comes-home-vfx/
http://www.animationboss.net/annabelle-comes-home-vfx/
http://www.animationboss.net/catch-22-vfx/
http://www.animationboss.net/catch-22-vfx/
http://www.animationboss.net/catch-22-vfx/#respond
http://www.animationboss.net/spider-man-far-from-home-vfx/
http://www.animationboss.net/
http://www.animationboss.net/
http://www.animationboss.net/category/vfx-breakdown/
https://www.abvfxstudios.com/
https://www.facebook.com/messages/t/Theanimationboss
http://www.animationboss.net/about/
http://www.animationboss.net/contact/

Cycle through tools with

the same shortcut key

Cycle through hidden
tools

Move tool

Rectangular Marquee
tool?

Elliptical Marquee tool

Lasso tool
Polygonal Lasso tool

Magnetic Lasso tool

Magic Wand tool

Quick Selection tool

Crop tool
Slice tool

Slice Select tool

Eyedropper tool*

Color Sampler tool

Shift-press
shortcut key (if
Use Shift Key
for Tool Switch
preference is
selected)

Alt-click + tool
(except Add
Anchor Point,
Delete Anchor
Point, and
Convert Point
tools)

vV

M

Shift-press
shortcut key (if
Use Shift Key for
Tool Switch
preference is
selected)

Option-click +
tool (except Add
Anchor Point,
Delete Anchor
Point, and
Convert Point
tools)
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Maleficent: Mistress of
Evil official Trailer
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Angry Bird Animation Animation
Movies Avengers Infinity War
Behind the Scenes Blade
Runner 2049 Brainstorm

Digital Breakdown cG Commercial
Dark David Jones Digital District
Disney Early Man Faint 2 Fusefx
Game of Thrones Game of Thrones
7 GIFsmetHarry Image Engine Jobs
Jumaniji Jurassic World Legend 3D

Making Mersal Milk VFX Minions

MPC Mr. X Netf“X nvizible
Oscar Rodeo FX solvrx
special Stopmotion Trixter TVC

VEXVFX
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Note tool

Spot Healing Brush tool

Healing Brush tool
Patch tool

Red Eye tool

Brush tool
Pencil tool
Color Replacement tool

Mixer Brush tool

Clone Stamp tool

Pattern Stamp tool

History Brush tool

Art History Brush tool

Eraser tool’
Background Eraser tool

Magic Eraser tool

Gradient tool

Paint Bucket tool

Dodge tool
Burn tool

Sponge tool
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EffeCtS Weta Digital Zoic

Trending

Adobe Photoshop CC
Keyboard Shortcuts

Tom and Jerry: How classical
Animation were Made

Joy Story: Animated Short Film
by Passion Pictures

Adobe Animate keyboard
shortcuts

12 Principles of Animation
"Bilby" Animated Short Film

Avengers: Infinity War VFX
Breakdown

No7 'The Wave' Commercial
Breakdown

Avengers: Endgame VFX
Breakdown

“The Little Duck” Disney's
Animated Short Film
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@A HOME NEws -

Freeform Pen tool

Horizontal Type tool
Vertical Type tool
Horizontal Type mask tool

Vertical Type mask tool

Path Selection tool

Direct Selection tool

Rectangle tool
Rounded Rectangle tool
Ellipse tool

Polygon tool

Line tool

Custom Shape tool

Hand tool®
Rotate View tool
Zoom tool'

Default
Foreground/Background
colors

Switch
Foreground/Background
colors

Toggle Standard/Quick
Mask modes

Content-Aware Move

VFX BREAKDOWN  ABSTUDIOS JOBS v CHAT ABOUTUS CONT

T T
A A
u u
H H
R R
z Z
D D
X X
Q Q
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Perspective Crop tool C C

Artboard tool \Y \Y

Rotate View tool R R

Toggle Preserve / (forward / (forward slash)
Transparency slash)

Decrease Brush { {

Hardness

Increase Brush } }

Hardness

Previous Brush , ,

Next Brush
First Brush < <
Last Brush > >

TUse same shortcut key for Liquify

View images

This partial list provides shortcuts that don't appear in menu
commands or tool tips.

Result Windows macOS

Cycle through open Control + Tab Control + Tab
documents

Switch to previous Shift + Control +  Shift +
document Tab Command +

“(grave accent)

Close afile in Shift-Control-W  Shift-Command-
Photoshop and open W
Bridge
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Quick Mask mode

Toggle (forward)

between Standard
screen mode, Full
screen mode with menu
bar, and Full screen

mode

Toggle (backward)
between Standard
screen mode, Full
screen mode with menu
bar, and Full screen

mode

Toggle (forward) canvas

color

Toggle (backward)

canvas color

Fit image in window

Magnify 100%

Switch to Hand tool
(when not in text-edit

mode)

Simultaneously pan
multiple documents

with Hand tool

F

Shift + F

Spacebar + F (or
right-click
canvas
background and
select color)

Spacebar + Shift
+F

Double-click
Hand tool

Double-click
Zoom tool or

Ctrl + 1

Spacebar

Shift-drag

Shift + F

Spacebar + F (or
Control-click
canvas
background and
select color)

Spacebar + Shift
+F

Double-click
Hand tool

Double-click
Zoom tool or

Command + 1

Spacebar

Shift-drag
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Switch to Zoom Out tool

Move Zoom marquee
while dragging with the
Zoom tool

Apply zoom percentage,
and keep zoom
percentage box active

Zoom in on specified
area of an image

Temporarily zoom into
an image

Scroll image with Hand
tool

Scroll up or down 1
screen

Scroll up or down 10
units

Move view to upper-left
corner or lower-right
corner

Toggle layer mask
on/off as rubylith (layer
mask must be selected)

Alt + spacebar

Spacebar-drag

Shift + Enter in
Navigator panel
zoom
percentage box

Control-drag
over preview in
Navigator panel

Hold down H
and then click in
the image and
hold down the
mouse button

Spacebar-drag,
or drag view
area boxin
Navigator panel

Page Up or
Page Down'

Shift + Page Up
or Page Downf

Home or End

\ (backslash)

Option +
spacebar

Spacebar-drag

Shift + Return in
Navigator panel
zoom

percentage box

Command-drag
over preview in
Navigator panel

Hold down H
and then click in
the image and
hold down the
mouse button

Spacebar-drag,
or drag view
area box in
Navigator panel

Page Up or Page
Down'

Shift + Page Up
or Page Down'

Home or End

\ (backslash)
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Use Puppet Warp

This partial list provides shortcuts that don't appear in menu

commands or tool tips.

Result

Cancel completely

Undo last pin adjustment
Select all pins

Deselect all pins

Select multiple pins

Move multiple selected pins

Temporarily hide pins

Use Refine Edge

Result

Open the Refine Edge dialog box

Cycle (forward) through preview
modes

Cycle (backward) through preview
modes

Toggle between original image and
selection preview

Toggle between original selection
and refined version

Windows macOS
Esc Esc
Ctrl+Z Command +Z
Ctrl + A Command + A
Ctrl+D Command + D
Shift-click Shift-click
Shift-drag  Shift-drag
H H
Windows macOS
Control+ Command +
Alt+R Option +R
F F
Shift + F Shift + F
X X
P P
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Toggle between Refine Radius and

Erase Refinements tools

Shift + E

Shift + E

Use the Filter Gallery

Result

Apply a new filter on
top of selected

Reapply last-used
filter

Open/close all
disclosure triangles

Change Cancel
button to Default

Change Cancel
button to Reset

Undo/Redo

Step forward

Step backward

Windows

Alt-click a filter

Control + Alt+ F

Alt-click a
disclosure
triangle

Control

Alt

Control +Z

Control + Shift +
Z

Control + Alt + Z

macOS

Option-click a filter

Control +
Command + F

Option-click a
disclosure triangle

Command

Option

Command +Z

Command + Shift +
Z

Command +
Option +Z

Use the Liquify filter

Result

Forward Warp
tool

Windows

W

macOS

W
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Iwirl Clockwise
tool

Pucker tool
Bloat tool

Push Left tool
Mirror tool
Turbulence tool
Freeze Mask tool
Thaw Mask tool

Reverse direction
for Bloat, Pucker,
Push Left, and
Mirror tools

Continually
sample the
distortion

Decrease/increase
brush size by 2, or
density, pressure,

rate, or turbulent

jitter by 1

Decrease/increase
brush size by 2, or
density, pressure,

rate, or turbulent

jitter by 1

< O W

_|

F
D

Alt + tool

Alt-drag in preview
with Reconstruct
tool, Displace,
Amplitwist, or
Affine mode
selected

Down Arrow/Up
Arrow in Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
text box!

Left Arrow/Right
Arrow with Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
slider showing'’

< O w

—

F
D

Option + tool

Option-drag in
preview with
Reconstruct tool,
Displace,
Amplitwist, or
Affine mode
selected

Down Arrow/Up
Arrow in Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
text box!

Left Arrow/Right
Arrow with Brush
Size, Density,
Pressure, Rate, or
Turbulent Jitter
slider showing'’
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controls on right

from top

Cycle through Shift + Tab Shift + Tab
controls on right

from bottom

Change Cancelto  Alt Option

Reset

"Hold down Shift to decrease/increase by 10

Use Vanishing Point

Result
Zoom 2x (temporary)

Zoomin

Zoom out

Fit in view

Zoom to center at
100%

Increase brush size
(Brush, Stamp tools)

Decrease brush size
(Brush, Stamp tools)

Increase brush
hardness (Brush,
Stamp tools)

Windows
X

Control + +
(plus)

Control + -
(hyphen)

Control+ 0
(zero), Double-
click Hand tool

Double-click
Zoom tool

]

Shift + ]

macOS
X

Command + +
(plus)

Command + -
(hyphen)

Command + 0
(zero), Double-
click Hand tool

Double-click
Zoom tool

]

Shift + ]
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Stamp tools)
Undo last action

Redo last action

Deselect all

Hide selection and
planes

Move selection 1 pixel

Move selection 10
pixels

Copy

Paste

Repeat last duplicate
and move

Create a floating
selection from the
current selection

Fill a selection with
image under the
pointer

Create a duplicate of
the selection as a
floating selection

Constrain selection to
a 15° rotation

Select a plane under
another selected plane

Create 90 degree
plane off parent plane

Control + Z

Control + Shift +
Z

Control + D

Control + H

Arrow keys

Shift + arrow
keys

Control + C
Control +V

Control + Shift +
-

Control + Alt+T

Control-drag

Control + Alt-
drag

Alt + Shift to
rotate

Control-click the
plane

Control-drag

Command +Z

Command + Shift
+7Z

Command + D

Command + H

Arrow keys

Shift + arrow keys

Command + C
Command +V

Command + Shift
+T

Command-drag

Command +
Option-drag

Option + Shift to
rotate

Command-click
the plane

Command-drag
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w

Make a full canvas Double-click the  Double-click the
plane, square to the Create Plane Create Plane tool
camera tool

Use the Camera Raw dialog
box

Note:Holding down a key temporarily activates a tool. Letting go of
the key returns to the previous tool.

Result Windows macOS
Zoom tool YA YA
Hand tool H H

White Balance tool I [

Color Sampler tool S S

Crop tool C C

Straighten tool A A

Spot Removal tool B B

Red Eye Removal tool E E

Basic panel Ctrl + Alt Command + Option
+ 1 +1

Tone Curve panel Ctrl + Alt Command + Option
+2 +2

Detail panel Ctrl + Alt Command + Option
+3 +3

HSL/Grayscale panel Ctrl + Alt Command + Option
+4 +4

Split Toning panel Ctrl + Alt Command + Option
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Lens Corrections panel

Camera Calibration panel

Presets panel

Open Snapshots panel

Parametric Curve
Targeted Adjustment tool

Hue Targeted
Adjustment tool

Saturation Targeted
Adjustment tool

Luminance Targeted
Adjustment tool

Grayscale Mix Targeted
Adjustment tool

Last-used Targeted
Adjustment tool

Adjustment Brush tool
Graduated Filter tool

Increase/decrease brush
Size

Increase/decrease brush

Ctrl + Alt
+6

Ctrl + Alt
+7

Ctrl + Alt
+9

Ctrl + Alt
+9

Ctrl + Alt
+ Shift+ T

Ctrl + Alt
+ Shift +
H

Ctrl + Alt
+ Shift + S

Ctrl + Alt
+ Shift + L

Ctrl + Alt
+ Shift +
G

T

171

Shift +1/

Command + Option
+6

Command + Option
+7

Command + Option
+ 9 (macOS Universal
Access zoom
shortcut must be
disabled in System
Preferences)

Command + Option
+9

Command + Option
+Shift+T

Command + Option
+ Shift + H

Command + Option
+ Shift + S

Command + Option
+ Shift + L

Command + Option
+ Shift + G

171

Shift + 1/ Shift + [
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Increase/decrease
Adjustment Brush tool
flow in increments of 10

Temporarily switch from
Add to Erase mode for
theAdjustment

Brush tool, or from Erase
to Add mode

Increase/decrease
temporary Adjustment
Brush tool size

Increase/decrease
temporary Adjustment
Brush tool feather

Increase/decrease
temporary Adjustment
Brush tool flow in
increments of 10

Switch to New mode
from Add or Erase mode
of theAdjustment

Brush tool or

the Graduated Filter

Toggle Auto Mask for
Adjustment Brush tool

Toggle Show Mask for
Adjustment Brush tool

Toggle pins for
Adjustment Brush tool

Toggle overlay for
Graduated Filter, Spot
Removal tool, or Red Eye

= (equal
sign) / -
(hyphen)

Alt

Alt+1]/
Alt+[

Alt + Shift
+]/Alt+
Shift + [

Alt+=
(equal
sign) / Alt
+ -

(hyphen)

N

M

Y

= (equal sign) / -
(hyphen)

Option

Option + ]/ Option +
[

Option + Shift+]/
Option + Shift + [

Option = (equal sign)
/ Option + - (hyphen)
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Rotate image left L or Ctrl +
]

Rotate image right Ror Ctrl +
[

Zoom in Ctrl + +
(plus)

Zoom out Ctrl + -
(hyphen)

Temporarily switch to Ctrl

Zoom In tool

(Doesn't work when
Straighten tool is selected.
If Crop tool is active,
temporarily switches to
Straighten tool.)

Temporarily switch to Alt
Zoom Out tool and

change the Open

Image button to Open

Copy and the Cancel

button to Reset.

Toggle preview P
Full screen mode F

Temporarily activate the Shift
White Balance tool and

change the Open

Image button to Open

Object.

(Does not work if Crop tool
is active)

Select multiple points in Click the

L or Command + ]

R or Command + [

Command + + (plus)

Command + -

(hyphen)

Command

Option

Shift

Click the first point;
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Add point to curve in
Curves panel

Move selected pointin
Curves panel (1 unit)

Move selected pointin
Curves panel (10 units)

Open selected images in
Camera Raw dialog box
from Bridge

Open selected images
from Bridge bypassing
Camera Raw dialog box

Display highlights that
will be clipped in Preview

Highlight clipping
warning

Shadows clipping
warning

(Filmstrip mode) Add 1 -
5 star rating

(Filmstrip mode)
Increase/decrease rating

oy
Shift-click
additional
points

Control-
click in
preview

Arrow
keys

Shift-
arrow

Ctrl+R

Shift +
double-
click
image

Alt-drag
Exposure,
Recovery,
or Black
sliders

@)

Ctrl+1 -5

Ctrl +.
(period) /
Ctrl+,
(comma)

Command-click in
preview

Arrow keys

Shift-arrow

Command + R

Shift + double-click
image

Option-drag
Exposure, Recovery,
or Black sliders

Command+1-5

Command + .
(period) /
Command+,
(comma)
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label

(Filmstrip mode) Add Ctrl+7 Command + 7
yellow label

(Filmstrip mode) Add Ctrl + 8 Command + 8
green label

(Filmstrip mode) Add Ctrl+9 Command + 9
blue label

(Filmstrip mode) Add Ctrl + Command + Shift + 0
purple label Shift + 0

Camera Raw preferences  Ctrl + K Command + K
Deletes Adobe Camera Ctrl + Alt Option + Shift (on
Raw preferences (on open) open)

Use the Black-and-White
dialog box

Result Windows macOS

Open the Black-and- Shift + Control +  Shift +

White dialog box Alt+B Command +
Option+ B

Increase/decrease
selected value by 1%

Up Arrow/Down
Arrow

Up Arrow/Down
Arrow

Increase/decrease Shift + Up Shift + Up
selected value by 10% Arrow/Down Arrow/Down
Arrow Arrow
Change the values of Click-drag on Click-drag on
the closest color slider the image the image
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Result

Open the Curves dialog
box

Select next point on the
curve

Select the previous
point on the curve

Select multiple points
on the curve

Deselect a point

To delete a point on the
curve

Move the selected point
1 unit

Move the selected point
10 units

Display highlights and
shadows that will be
clipped

Set a point to the
composite curve

Set a point to the
channel curves

Toggle grid size

Windows

Control + M

+ (plus)

- (minus)

Shift-click the
points

Control+ D

Select a point
and press
Delete

Arrow keys

Shift + Arrow
keys

Alt-drag
black/white
point sliders

Control-click
the image

Shift + Control-
click the image

Alt-click the
field

macOS

Command + M

+ (plus)

- (minus)

Shift-click the
points

Command + D

Select a point
and press Delete

Arrow keys

Shift + Arrow
keys

Option-drag
black/white point
sliders

Command-click
the image

Shift +
Command-click
the image

Option-click the
field
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This partial list provides shortcuts that don't appear in menu

commands or tool tips.

Result

Reposition
marquee while
selecting*

Add to a selection

Subtract from a
selection

Intersect a
selection

Constrain
marquee to
square or circle (if
no other
selections are
active)*

Draw marquee
from center (if no
other selections
are active)*

Constrain shape
and draw
marquee from
center#

Switch to Move

Windows

Any marquee tool
(except single
column and single
row) + spacebar-
drag

Any selection tool
+ Shift-drag

Any selection tool
+ Alt-drag

Any selection tool
(except Quick
Selection tool) +
Shift-Alt-drag

Shift-drag

Alt-drag

Shift + Alt-drag

Control (except

macOS

Any marquee tool
(except single
column and single
row) + spacebar-
drag

Any selection tool +
Shift-drag

Any selection tool +
Option-drag

Any selection tool
(except Quick
Selection tool) +
Shift-Option-drag

Shift-drag

Option-drag

Shift + Option-drag

Command (except
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Switch from
Magnetic Lasso
tool to Lasso tool

Switch from
Magnetic Lasso
tool to polygonal
Lasso tool

Apply/cancel an
operation of the
Magnetic Lasso

Move copy of
selection

Move selection
area 1 pixel

Move selection 1
pixel

Move layer 1 pixel
when nothing
selected on layer

Increase/decrease
detection width

Accept cropping
or exit cropping

Toggle crop shield

any Pen tool is
selected)

Alt-drag

Alt-click

Enter/Esc or
Control + . (period)

Move tool + Alt-
drag selection?

Any selection +
Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow’

Move tool + Right
Arrow, Left Arrow,
Up Arrow, or
Down Arrow'#

Control + Right
Arrow, Left Arrow,
Up Arrow, or
Down Arrow?

Magnetic Lasso
tool +[or]

Crop tool + Enter
or Esc

/ (forward slash)

Pen tool is selected)

Option-drag

Option-click

Return/Esc or
Command +.
(period)

Move tool +
Option-drag
selectioni

Any selection +
Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow?’

Move tool + Right
Arrow, Left Arrow,
Up Arrow, or Down
Arrow'

Command + Right
Arrow, Left Arrow,
Up Arrow, or Down
Arrow!

Magnetic Lasso tool
+[or]

Crop tool + Return
or Esc

/ (forward slash)
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Make protractor

Snap guide to
ruler ticks (except
when View > Snap
is unchecked)

Convert between
horizontal and
vertical guide

Ruler tool + Alt-
drag end point

Shift-drag guide

Alt-drag guide

"Hold down Shift to move 10 pixels

“Applies to shape tools

Ruler tool + Option-
drag end point

Shift-drag guide

Option-drag guide

Transform selections,
selection borders, and

paths

This partial list provides shortcuts that don't appear in menu

commands or tool tips.

Result

Transform from
center or reflect

Constrain
Distort
Apply

Cancel

Free transform with
duplicate data

Windows

Alt

Shift
Control
Enter

Control +.
(period) or Esc

Control + Alt +
-

macOS

Option

Shift
Command
Return

Command +.
(period) or Esc

Command +
Option +T
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Edit paths

This partial list provides shortcuts that don't appear in menu
commands or tool tips.

Result

Select multiple anchor

points

Select entire path

Duplicate a path

Switch from Path

Windows

Direct
selection tool +
Shift-click

Direct
selection tool +
Alt-click

Pen (any Pen
tool), Path
Selection or
Direct
Selection tool
+ Control + Alt-
drag

Control

macOS

Direct selection
tool + Shift-click

Direct selection
tool + Option-
click

Pen (any Pen
tool), Path
Selection or
Direct Selection
tool + Command
+ Option-drag

Command

Selection, Pen, Add
Anchor Point, Delete
Anchor Point, or Convert
Point tools to Direct
Selection tool

Switch from Pen toolor  Alt Option
Freeform Pen tool to

Convert Point tool when

pointer is over anchor

or direction point

Close path Magnetic Pen Magnetic Pen
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Close path with straight-  Magnetic Pen
tool + Alt-

double-click

Magnetic Pen
line segment tool + Option-

double-click

Use for painting

This partial list provides shortcuts that don't appear in menu
commands or tool tips.

Result Windows macOS

Select Any painting tool + Any painting tool +
foreground  Shift + Alt + right-click ~ Control + Option +
color from and drag Command and drag
color picker

Select Any painting tool + Alt ~ Any painting tool +
foreground  or any shape tool + Alt  Option or any shape
color from (except when Paths tool + Option (except
image with  option is selected) when Paths option is
Eyedropper selected)

tool

Select Eyedropper tool + Alt-  Eyedropper tool +
background click Option-click

color

Color Eyedropper tool + Eyedropper tool +
sampler Shift Shift

tool

Deletes Color sampler tool + Color sampler tool +
color Alt-click Option-click

sampler

Sets Any painting or Any painting or
opacity, editing tool + number  editing tool + number
tolerance, keys (e.g., 0 =100%, 1 keys (e.g., 0 = 100%, 1
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for painting
mode

Sets flow
for painting
mode

Mixer
Brush
changes
Mix setting

Mixer
Brush
changes
Wet setting

Mixer
Brush
changes
Wet and
Mix to zero

Cycle
through
blending
modes

Open Fill
dialog box
on
background
or standard
layer

45%) (when airbrush
option is enabled, use
Shift + number keys)

Any painting or
editing tool + Shift +
number keys (e.g., 0 =
100%, 1 = 10%, 4 then
5 in quick succession
= 45%) (when airbrush
option is enabled,
omit Shift)

Alt + Shift + number

Number keys

00

Shift + + (plus) or -
(minus)

Backspace or Shift +

Backspace

45%) (when airbrush
option is enabled, use
Shift + number keys)

Any painting or
editing tool + Shift +
number keys (e.g., 0 =
100%, 1 = 10%, 4 then
5in quick succession
= 45%) (when airbrush
option is enabled,
omit Shift)

Option + Shift +
number

Number keys

00

Shift + + (plus) or -
(minus)

Delete or Shift + Delete
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roregrouriu LOIMLrol + bdlKspdee’

or
background

color

Fill from Control + Alt +
history Backspace’

Displays Fill  Shift + Backspace
dialog box

Lock / (forward slash)
transparent

pixels

on/off

Connects Any painting tool +
points with  Shift-click

a straight

line

COIlnirdriua + pelewe’

Command + Option +
Deletef

Shift + Delete

/ (forward slash)

Any painting tool +
Shift-click

"Hold down Shift to preserve transparency

Use for blending modes

Result Windows macOS

Cycle through blending Shift + + Shift + + (plus)

modes (plus) or - or - (minus)
(minus)

Normal Shift + Alt + Shift + Option
N + N

Dissolve Shift + Alt+1  Shift + Option

+

Behind (Brush tool only) Shift + Alt + Shift + Option

Q +Q

Clear (Brush tool only) Shift + Alt + Shift + Option
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HOME

S NEWS

Darken

Multiply

Color Burn

Linear Burn

Lighten

Screen

Color Dodge

Linear Dodge

Overlay

Soft Light

Hard Light

Vivid Light

Linear Light

Pin Light

Hard Mix

VFX BREAKDOWN
Shirt + Alt +
K

Shift + Alt +
M

Shift + Alt +
B

Shift + Alt +
A

Shift + Alt +
G

Shift + Alt +
S

Shift + Alt +
D

Shift + Alt +
W

Shift + Alt +
@)

Shift + Alt +
F

Shift + Alt +
H

Shift + Alt +
Vv

Shift + Alt +

Shift + Alt +
Z

Shift + Alt +
L

AB STUDIOS ~ JOBS v
Shitt + Option
+K

Shift + Option
+M

Shift + Option
+B

Shift + Option
+A

Shift + Option
+G

Shift + Option
+S

Shift + Option
+D

Shift + Option
+W

Shift + Option
+0

Shift + Option
+F

Shift + Option
+H

Shift + Option
+V

Shift + Option
+)
Shift + Option
+Z

Shift + Option
+L

CHAT

ABOUT US

CONT
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Exclusion

Hue

Saturation

Color

Luminosity

Desaturate

Saturate

Dodge/burn shadows

Dodge/burn midtones

Dodge/burn highlights

Set blending mode to
Threshold for bitmap images,
Normal for all other images

Shift + Alt +
X

Shift + Alt +
U

Shift + Alt +
-

Shift + Alt +
C

Shift + Alt +
Y

Sponge tool
+ Shift + Alt
+D

Sponge tool
+ Shift + Alt
+S

Dodge
tool/Burn
tool + Shift +
Alt+S

Dodge
tool/Burn
tool + Shift +
Alt+ M

Dodge
tool/Burn
tool + Shift +
Alt+H

Shift + Alt +
N

Shift + Option
+X

Shift + Option
+U

Shift + Option
+T

Shift + Option
+C

Shift + Option
+Y

Sponge tool +
Shift + Option
+D

Sponge tool +
Shift + Option
+S

Dodge
tool/Burn tool
+ Shift +
Option +S

Dodge
tool/Burn tool
+ Shift +
Option + M

Dodge
tool/Burn tool
+ Shift +
Option + H

Shift + Option
+N
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This partial list provides shortcuts that don't appear in menu

commands or tool tips.

Result

Move type in image

Select 1 character
left/right or 1 line
down/up, or 1 word
left/right

Select characters
from insertion point
to mouse click point

Move 1 character
left/right, 1 line
down/up, or 1 word
left/right

Create a new text
layer, when a text
layer is selected in
the Layers panel

Select a word, line,
paragraph, or story

Windows

Control-drag
type when Type
layer is selected

Shift + Left
Arrow/Right
Arrow or Down
Arrow/Up Arrow,
or Control + Shift
+ Left
Arrow/Right
Arrow

Shift-click

Left Arrow/Right
Arrow, Down
Arrow/Up Arrow,
or Control + Left
Arrow/Right
Arrow

Shift-click

Double-click,
triple-click,
quadruple-click,
or quintuple-click

macOS

Command-drag
type when Type
layer is selected

Shift + Left
Arrow/Right
Arrow or Down
Arrow/Up Arrow,
or Command +
Shift + Left
Arrow/Right
Arrow

Shift-click

Left Arrow/Right
Arrow, Down
Arrow/Up Arrow,
or Command +
Left Arrow/Right
Arrow

Shift-click

Double-click,
triple-click,
quadruple-click,
or quintuple-click
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Display the bounding
box for transforming
text when editing
text, or activate Move
tool if cursor is inside
the bounding box

Scale text within a
bounding box when
resizing the bounding
box

Move text box while
creating text box

Control

Control-drag a
bounding box
handle

Spacebar-drag

Format type

Command

Command-drag a
bounding box
handle

Spacebar-drag

This partial list provides shortcuts that don't appear in menu

commands or tool tips.

Result

Align left, center, or
right

Align top, center, or
bottom

Choose 100%
horizontal scale

Choose 100% vertical
scale

Choose Auto leading

Windows

Horizontal Type
tool + Control +
Shift+L, C,orR

Vertical Type
tool + Control +
Shift+ L, C,or R

Control + Shift +
X

Control + Shift +
Alt + X

Control + Shift +
Alt + A

macOS

Horizontal Type
tool + Command
+ Shift+L, C, orR

Vertical Type tool
+ Command +
Shift+ L, C, orR

Command + Shift
+ X

Command + Shift
+ Option + X

Command + Shift
+ Option + A
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Justify paragraph, left
aligns last line

Justify paragraph,
justifies all

Toggle paragraph
hyphenation on/off

Toggle single/every-
line composer on/off

Decrease or increase
type size of selected
text 2 points or pixels

Decrease or increase
leading 2 points or
pixels

Decrease or increase
baseline shift 2 points
or pixels

Decrease or increase
kerning/tracking
20/1000 ems

Control + Shift +
J

Control + Shift +
F

Control + Shift +
Alt+H

Control + Shift +
Alt+T

Control + Shift +
<or >t

Alt + Down
Arrow or Up
Arrow't

Shift + Alt +
Down Arrow or
Up Arrow'®

Alt + Left Arrow
or Right Arrow'

Q

Command + Shift
+)

Command + Shift
+F

Command +
Control + Shift +
Option + H

Command + Shift
+ Option +T

Command + Shift
+ < or >t

Option + Down
Arrow or Up
Arrow'?

Shift + Option +
Down Arrow or
Up Arrow't

Option + Left
Arrow or Right
Arrow'

"Hold down Alt (Win) or Option (macOS) to decrease/increase

by 10

THold down Ctrl (Windows) or Command (macOS) to

decrease/increase by 10

Slice and optimize
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loggle between Slice tool and control Command

Slice Selection tool

Draw square slice Shift-drag  Shift-drag

Draw from center outward Alt-drag Option-drag

Draw square slice from center Shift + Shift +

outward Alt-drag Option-drag

Reposition slice while creating Spacebar-  Spacebar-

slice drag drag

Open context-sensitive menu Right- Control-click
click slice  slice

Use panels

This partial list provides shortcuts that don't appear in menu
commands or tool tips.

Result Windows macOS

Set options for new items Alt-click New  Option-click

(except for Actions, Animation,  button New button

Styles, Brushes, Tool Presets,

and Layer Comps panels)

Delete without confirmation Alt-click Option-click

(except for the Brush panel) Delete Delete
button button

Apply value and keep text box Shift + Enter ~ Shift +

active Return

Show/Hide all panels Tab Tab

Show/Hide all panels except Shift + Tab Shift + Tab

the toolbox and options bar

Highlight options bar Select tool Select tool
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Increase/decrease selected

values by 10

Shift + Up Shift + Up
Arrow/Down  Arrow/Down
Arrow Arrow

Use the Actions panel

Result

Turn command on
and all others off, or
turn all commands on

Turn current modal
control on and toggle
all other modal
controls

Change action or
action set options

Display Options dialog
box for recorded
command

Play entire action

Collapse/expand all
components of an
action

Play a command

Create new action and
begin recording

Windows

Alt-click the
check mark next
to a command

Alt-click

Alt + double-click
action or action
set

Double-click
recorded
command

Control +
double-click an
action

Alt-click the
triangle

Control-click the
Play button

Alt-click the New
Action button

macOS

Option-click the
check mark next
to a command

Option-click

Option + double-
click action or
action set

Double-click
recorded
command

Command +
double-click an
action

Option-click the
triangle

Command-click
the Play button

Option-click the
New Action
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Select contiguous

items of the same kind

Select discontiguous
items of the same kind

Shift-click the
action/command

Control-click the
action/command

Shift-click the
action/command

Command-click
the
action/command

Use adjustment layers

Note:If you prefer channel shortcuts starting with Alt/Option + 1 for

red, choose Edit > Keyboard Shortcuts, and select Use Legacy Channel

Shortcuts. Then restart Photoshop.

Result

Choose specific
channel for
adjustment

Choose composite
channel for
adjustment

Delete adjustment
layer

Define Auto options
for Levels or Curves

Windows

Alt + 3 (red), 4
(green), 5 (blue)

Alt+2

Delete or
Backspace

Alt-click Auto
button

macOS
Option + 3 (red), 4
(green), 5 (blue)

Option + 2

Delete

Option-click Auto
button

Use the Animation panel in
Frames mode

Result

Select/deselect
multiple
contiguous frames

Windows

Shift-click second
frame

macOS

Shift-click second
frame
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discontiguous
frames

Paste using
previous settings

without displaying

the dialog box

Alt + Paste
Frames command
from the Panel
pop-up menu

Option + Paste
Frames command
from the Panel
pop-up menu

Use the Brush panel

Result

Delete brush

Rename brush

Change brush size

Decrease/increase

brush

softness/hardness

Select previous/next

brush size

Select first/last brush

Display precise cross

hair for brushes

Toggle airbrush option

Windows

Alt-click brush

Double-click
brush

Alt + right-click +
drag left or right

Alt + right-click +
drag up or down

, (comma) or.
(period)

Shift +, (comma)

or . (period)

macOS

Option-click
brush

Double-click
brush

Ctrl + Option +
drag left or right

Ctrl + Option +
drag up or
down

, (comma) or.
(period)

Shift +,
(comma) or.
(period)

Caps Lock or
Shift + Caps Lock

Shift + Alt + P

Caps Lock

Shift + Option +
P
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Note:lf you prefer channel shortcuts starting with Ctrl/Command + 1

for red, choose Edit > Keyboard Shortcuts, and select Use Legacy

Channel Shortcuts.

Result

Select individual
channels

Select
composite
channel

Load channel as
selection

Add to current
selection

Subtract from
current
selection

Intersect with
current
selection

Set options for
Save Selection
As Channel
button

Create a new
spot channel

Select/deselect

Windows

Ctrl + 3 (red), 4
(green), 5 (blue)

Ctrl+ 2

Control-click
channel
thumbnail, or Alt
+ Ctrl + 3 (red), 4
(green), 5 (blue)

Control + Shift-
click channel
thumbnail

Control + Alt-click
channel
thumbnail

Control + Shift +
Alt-click channel
thumbnail

Alt-click Save
Selection As
Channel button

Control-click
Create New
Channel button

Shift-click color

macOS

Command + 3 (red), 4
(green), 5 (blue)

Command + 2

Command-click
channel thumbnail, or
Option + Command +
3 (red), 4 (green), 5
(blue)

Command + Shift-click
channel thumbnail

Command + Option-
click channel
thumbnail

Command + Shift +
Option-click channel
thumbnail

Option-click Save
Selection As Channel
button

Command-click
Create New Channel
button

Shift-click color
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selection

Select/deselect
alpha channel

Shift-click alpha
channel

Shift-click alpha
channel

and show/hide
as a rubylith
overlay

Display channel  Double-click Double-click alpha or

options alpha or spot spot channel
channel thumbnail
thumbnail

Toggle ~ (tilde) ~ (tilde)

composite and
grayscale mask
in Quick Mask
mode

Use the Clone Source panel

Result Windows macOS

Show Clone Source Alt + Shift Option + Shift

(overlays image)

Nudge Clone Source Alt + Shift + Option + Shift +
arrow keys arrow keys

Rotate Clone Source Alt + Shift + < Option + Shift +
or > <or>

Scale (increase or reduce Alt + Shift + [ Option + Shift +

size) Clone Source or] [or]

Use the Color panel
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Select background
color

Display Color Bar
menu

Cycle through
color choices

Alt-click color Iin
color bar

Right-click color
bar

Shift-click color
bar

Option-click color In
color bar

Control-click color
bar

Shift-click color bar

Use the History panel

Result

Create a new
snapshot

Rename snapshot

Step forward
through image
states

Step backward
through image
states

Duplicate any
image state,
except the current
state

Permanently clear
history (no Undo)

Use the Info panel

Windows

Alt + New
Snapshot

Double-click

snapshot name

Control + Shift+ Z

Control + Alt+ Z

Alt-click the image
state

Alt + Clear History
(in History panel
pop-up menu)

macOS

Option + New
Snapshot

Double-click
snapshot name

Command + Shift +
Z

Command + Option
+Z

Option-click the
image state

Option + Clear
History (in History
panel pop-up
menu)
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Change color readout

modes

Change measurement

units

icon

Click crosshair
icon

Click eyedropper

Click eyedropper
icon

Click crosshair
icon

Use the Layers panel

Result

Load layer
transparency as a
selection

Add to current
selection

Subtract from
current selection

Intersect with
current selection

Load filter mask
as a selection

New layer

New layer via
copy

New layer via cut
Group layers

Ungroup layers

Windows

Control-click layer
thumbnail

Control + Shift-
click layer
thumbnail

Control + Alt-click
layer thumbnail

Control + Shift +
Alt-click layer
thumbnail

Control-click filter

mask thumbnail

Control + Shift+ N

Control +

Shift + Control +
Control + G

Control + Shift + G

macOS

Command-click
layer thumbnail

Command + Shift-
click layer
thumbnail

Command + Option-
click layer
thumbnail

Command + Shift +
Option-click layer
thumbnail

Command-click
filter mask
thumbnail

Command + Shift+
N

Command +

Shift + Command +
Command + G

Command + Shift +
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Create/release
clipping mask

Select all layers

Merge visible
layers

Create new
empty layer with
dialog box

Create new layer
below target
layer

Select top layer

Select bottom
layer

Add to layer
selection in
Layers panel

Select next layer
down/up

Move target layer
down/up

Merge a copy of
all visible layers
into target layer

Merge layers

Move layer to
bottom or top

Control + Alt+ G

Control + Alt + A

Control + Shift + E

Alt-click New Layer
button

Control-click New
Layer button

Alt + . (period)

Alt +, (comma)

Shift + Alt + [ or ]

Alt+[or]

Control + [ or]

Control + Shift +
Alt+E

Highlight layers
you want to
merge, then
Control + E

Control + Shift + [
or]

Command + Option
+G

Command + Option
+A

Command + Shift +
E

Option-click New
Layer button

Command-click New
Layer button

Option + . (period)

Option +, (comma)

Shift + Option + [ or
]

Option +[ or]

Command + [ or]

Command + Shift +
Option + E

Highlight the layers
you want to merge,
then Command + E

Command + Shift + [
or]
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below

Merge all visible
layers to a new
layer above the
currently selected
layer

Show/hide this
layer/layer group
only or all
layers/layer
groups

Show/hide all
other currently
visible layers

Toggle lock
transparency for
target layer, or
last applied lock

Edit layer
effect/style,
options

Hide layer
effect/style

Edit layer style

Disable/enable
vector mask

Open Layer Mask
Display Options
dialog box

Toggle layer
mask on/off

the Panel pop-up
menu

Alt + Merge Visible
command from
the Panel pop-up
menu

Right-click the eye
icon

Alt-click the eye
icon

/ (forward slash)

Double-click layer
effect/style

Alt-double-click
layer effect/style

Double-click layer

Shift-click vector
mask thumbnail

Double-click layer
mask thumbnail

Shift-click layer
mask thumbnail

from the Panel
pop-up menu

Option + Merge
Visible command
from the Panel
pop-up menu

Control-click the eye
icon

Option-click the eye
icon

/ (forward slash)

Double-click layer
effect/style

Option-double-click
layer effect/style

Double-click layer

Shift-click vector
mask thumbnail

Double-click layer
mask thumbnail

Shift-click layer
mask thumbnail
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on/off

Toggle between
layer
mask/composite
image

Toggle between
filter
mask/composite
image

Toggle rubylith
mode for layer
mask on/off

Select all type;
temporarily
select Type tool

Create a clipping
mask

Rename layer

Edit filter settings

Edit the Filter
Blending options

Create new layer
group below
current
layer/layer set

Create new layer
group with dialog
box

Create layer

mask thumbnail

Alt-click layer
mask thumbnail

Alt-click filter mask
thumbnail

\ (backslash), or
Shift + Alt-click

Double-click type
layer thumbnail

Alt-click the line
dividing two layers

Double-click the
layer name

Double-click the
filter effect

Double-click the
Filter Blending
icon

Control-click New
Group button

Alt-click New
Group button

Alt-click Add Layer

mask thumbnail

Option-click layer
mask thumbnail

Option-click filter
mask thumbnail

\ (backslash), or
Shift + Option-click

Double-click type
layer thumbnail

Option-click the line
dividing two layers

Double-click the
layer name

Double-click the
filter effect

Double-click the
Filter Blending icon

Command-click New
Group button

Option-click New
Group button

Option-click Add
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Create vector
mask that reveals
all/path area

Create vector
mask that hides
all or displays
path area

Display layer
group properties

Select/deselect
multiple
contiguous layers

Select/deselect
multiple
discontiguous
layers

Control-click Add
Layer Mask button

Control + Alt-click
Add Layer Mask
button

Right-click layer
group and choose
Group Properties,
or double-click

group
Shift-click

Control-click

Command-click Add
Layer Mask button

Command + Option-
click Add Layer
Mask button

Control-click the
layer group and
choose Group
Properties, or
double-click group

Shift-click

Command-click

Note:If Kotoeri is your Japanese language input method, the “Toggle
rubylith mode for layer mask on/off” shortcut starts an action in
Kotoeri. Please switch to another mode (for example, “U.S.”) to enable
this shortcut.

Use the Layer Comps panel

Result Windows macOS

Alt-click Create
New Layer
Comp button

Create new layer comp
without the New Layer
Comp box

Option-click
Create New Layer
Comp button

Open Layer Comp Double-click Double-click layer
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Rename Iin-line Double-click

Double-click layer

layer comp comp name
name
Select/deselect Shift-click Shift-click
multiple contiguous
layer comps
Select/deselect Control-click Command-click

multiple discontiguous
layer comps

Use the Paths panel

Result

Load path as selection

Add path to selection

Subtract path from selection

Retain intersection of path as
selection

Hide path

Set options for Fill Path

Windows

Control-
click
pathname

Control +
Shift-click
pathname

Control +
Alt-click
pathname

Control +
Shift + Alt-
click
pathname

Control +
Shift + H

Alt-click

macOS

Command-
click
pathname

Command
+ Shift-click
pathname

Command
+ Option-
click
pathname

Command
+ Shift +
Option-
click
pathname

Command
+ Shift + H

Option-
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Load Path as a Selection button,
Make Work Path from Selection
button, and Create New Path
button

Use the Swatches panel

Result Windows macOS

Create new swatch from  Click in empty Click in empty

foreground color area of panel area of panel

Set swatch color as Control-click Command-click

background color swatch swatch

Delete swatch Alt-click swatch ~ Option-click
swatch

Use Extract and Pattern
Maker (optional plug-ins)

Result (Extract and Windows macOS
Pattern Maker)

Fit in window Control +0 Command + 0
Zoom in Control + + (plus) Command + +
(plus)
Zoom out Control + - Command + -
(hyphen) (hyphen)
Cycle through Tab Tab

controls on right
from top
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I duLcliin wvianci

Cycle through
controls on right
from bottom

Temporarily activate
Hand tool

Change Cancel to
Reset

Result (Extract only)

Edge Highlighter
tool

Fill tool
Eyedropper tool
Cleanup tool

Edge Touchup tool

Toggle between
Edge Highlighter
tool and Eraser tool

Toggle Smart
Highlighting

Remove current
highlight

Highlight entire
image

Fill foreground area
and preview
extraction

Shift + Tab

Spacebar

Alt

Windows

B

C
T

Alt + Edge
Highlighter/Eraser
tool

Control with Edge
Highlighter tool
selected

Alt + Delete

Control + Delete

Shift-click with Fill
tool selected

Shift + Tab

Spacebar

Option

macOS

C
-

Option + Edge
Highlighter/Eraser
tool

Command with
Edge Highlighter
tool selected

Option + Delete

Command +
Delete

Shift-click with Fill
tool selected
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I daLLCliin wvianci

Move mask when
Edge Touchup tool
is selected

Add opacity when
Cleanup tool is
selected

Toggle Show menu
options in preview
between Original
and Extracted

Enable Cleanup and
Edge Touchup tools

before preview

Cycle through
Display menu in

preview from top to

bottom

Cycle through
Display menu in
preview from
bottom to top

Decrease/increase
brush size by 1

Decrease/increase
brush size by 1

Set strength of
Cleanup or Edge
Touch-up tool

Control-drag

Alt-drag

Shift + X

Shift + F

Down Arrow/Up
Arrow in Brush
Size text box'

Left Arrow/Right
Arrow with Brush
Size Slider
showing’

0-9

Command-drag

Option-drag

Shift + X

Shift + F

Down Arrow or
Up Arrow in
Brush Size text
box?

Left Arrow/Right
Arrow with Brush
Size Slider
showing’

0-9
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I duLcliin wvianci

"Hold down Shift to decrease/increase by 10

Result (Pattern
Maker only)

Delete current
selection

Undo a selection
move

Generate or
generate again

Intersect with
current selection

Toggle view:
original/generated
pattern

Go to first tile in Tile
History

Go to last tile in Tile
History

Go to previous tile
in Tile History

Go to next tile in Tile
History

Delete current tile
from Tile History

Nudge selection
when viewing the
original

Windows

Control+ D

Control+Z

Control + G

Shift + Alt + select

Home

End

Left Arrow, Page
Up

Right Arrow, Page
Down

Delete

Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow

macOS

Command + D

Command +Z

Command + G

Shift + Option +
select

X

Home

End

Left Arrow, Page
Up

Right Arrow, Page
Down

Delete

Right Arrow, Left
Arrow, Up Arrow,
or Down Arrow
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Increase selection Shift + Right Shift + Right
nudging when Arrow, Left Arrow, Arrow, Left Arrow,
viewing the original Up Arrow, or Up Arrow, or

Down Arrow Down Arrow
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